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พัฒนาแอปพลิเคชันแบบ Multi-Platform ดวยคูมือ

.NETMAUI
Multi-platform One codebase Productive

เรียนรูพื้นฐานและเทคนิคการพัฒนา

แอปพลิเคชัน .NET ขามแพลตฟอรม

รองรับการพัฒนาแอปพลิเคชันบน

Android, MacOS, iOS, Windows

และ Web Base

พัฒนาโคดเพียงครั้งเดียวสามารถใชงาน

ไดทุกแพลตฟอรม

มีโคดตัวอยางและคำอธิบายอยางละเอียด

อานเขาใจงาย 

อธิบายเปนขั้นตอน เหมาะสำหรับผูเริ่มตน

มีประสบการณดานพัฒนาซอฟตแวร เว็บไซต และงานเขียนมากกวา 20 ป

มีผลงานหนังสือที ่ไดรับความนิยมมากมาย อาทิ

• เริ่มตน Coding สราง Mobile App อยางมืออาชีพดวย

  Kotlin และ Andriod Studio

• basic Coding สำหรับ Web Developer ดวย HTML5,

  CSS3 และ JavaScript

• Python Data Science เรียนรู Concept และฝกฝน Coding
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      ปจจุบันเทคโนโลยีมีความกาวหนาอยางมาก ทําใหหลายๆ

แพลตฟอรมไดรับความนิยมและนํามาใชงานกันอยางแพรหลาย

ไมวาจะเปนเคร�องคอมพิวเตอรที่ใชระบบปฏิบัติการ Windows,

โทรศัพทมือถือท่ีใชระบบปฏิบัติการ Android, โทรศัพทมือถือ

iPhone ท่ีใชระบบปฏิบัติการ iOS ซ่ึงทุกวันนี้ทุกแพลตฟอรมตอง

ทํางานรวมกันได จึงเปนท่ีมาของการพัฒนาแอปพลิเคชันบนทุก

แพลตฟอรม 

      หนังสือเลมน้ีขอแนะนํา .NET MAUI เปนโปรเจ็กตท่ีชวยให

นักพัฒนาสามารถสรางแอปพลิเคชันหลายแพลตฟอรมไดในเวลา

เดียวกันดวยโครงสรางโปรเจ็กตเพียงหน่ึงเดียว เขียนโคดเพียง

ครั้งเดียวไดแอปพลิเคชันท่ีสามารถใชงานไดบนทุกแพลตฟอรม

ชวยลดเวลาในการพัฒนา ดูแลรักษาโปรเจ็กตในระยะยาวไดอยางมี

ประสิทธิภาพ ซ่ึงหนังสือเลมน้ีไดอธิบายหลักพื้นฐานการพัฒนา

แอปพลิเคชันไวอยางละเอียด เปนขั้นตอน พรอมตัวอยางประกอบ

การอธบิายทุกหัวขอ สามารถนําไปพฒันาแอปพลเิคชนัใชงานไดจริง

ท้ังยังสามารถดาวนโหลดโคดภายในเลมประกอบการศึกษาดวย

ตัวเองไดอีกดวย 

แนะนำพื้นฐานการพัฒนาแอปดวย .NET MAUI 

แนะนำการใชงานตำแหนงและ Layout ขั้นตนของ .NET MAUI

อธิบายการใชงานคอนโทรล (Controls) หรืออีลีเมนต (Element)

พื้นฐานการผูกติดขอมูล (Data Binding)

แนะนำการสั่งใหเกิดการทำงานดวยคลาส Command

เรียนรูการพัฒนาแอปแบบหลายหนาจอ

พื้นฐานการสรางรายการดวย ListView

เรียนรูการทำงานกับฟงกชันพื้นฐานของอุปกรณ

Mobile Devices (.NET MAUI Essentials)

รูจักกับ .NET MAUI Blazor

พื้นฐานการสราง Web API ดวย ASP.NET Core Web API

เรียนรูการสราง .NET MAUI Apps แบบ CRUD เช�อมตอกับ

ASP.NET Core Web API (Front End และ Back End)

พื้นฐานการพัฒนา Web Apps แบบคอนเทนเนอรดวย Docker

เรียนรูการสราง ASP.NET Core Web API ดวย Docker

เรียนรูการเผยแพรอิมเมจแบบสาธารณะกับ Docker Registry

การสรางไฟล Signed APK และ Signed AAB ดวย .NET MAUI

การอัพโหลดแอปขึ้น Google Play Store

การสรางไฟลติดตั้งของ .NET MAUI แบบ Windows Apps





คู่มือพัฒนาแอปพลิเคชัน 
Multi-Platform ด้วย .NET MAUI

Author
ศุภชัย สมพานิช

Editorial
กิตินันท์ พลสวัสด์ิ  kitinan_p@idcpremier.com

Production Manager
วรพล ณธิกุล

Graphic Designer
ชวนันท์ รัตนะ

Page Layout
ปริเยศ จันทร์จ�ำปา

Proofreader
พรรณรัตน์ ขุราษี

Publishing Coordinators
สุรีย์รัตน์ จิอู๋, ฉัตรดนัย ศรีสวัสด์ิ

Product Specialist
ศรัณย์ คมข�ำ สร้างสรรค์โดย

พิมพ์ครั้งที่ 1  กันยายน 2566

ข้อมูลทางบรรณานุกรม
ศุภชัย สมพานิช

คู่มอืพัฒนาแอปพลิเคชัน Multi-Platform ด้วย .NET MAUI 

นนทบุรี : ไอดีซีฯ, 2566

448 หน้า

1. ภาษาที่ใช้ ในการเขยีนโปรแกรม

I ชื่อเรือ่ง

005.262

Barcode 885-916-101-058-6

ราคา 480 บาท

พิมพ์ที ่บริษัท ดี.เค.ปร้ินต้ิง จ�ากัด

441/56 หมู่ 2 ต.บางบ่อ อ.บางบ่อ จ.สมุทรปราการ 10650 

โทรศัพท์  0-2115-9105  โทรสาร  0-2115-9044

บริษัท ไอดีซี พรีเมียร์ จ�ำกัด
200 หมู่ 4 ช้ัน 19 ห้อง 1901 อาคารจัสมินอินเตอร์เนช่ันแนล

ทาวเวอร์ ถ.แจ้งวัฒนะ อ.ปากเกร็ด จ.นนทบุรี 11120

โทรศัพท์	 0-2962-1081 (อัตโนมัติ 10 คู่สาย)

โทรสาร	 0-2962-1084

สมาชิกสัมพันธ ์

โทรศัพท์	 0-2962-1081-3 ต่อ 121 

โทรสาร	 0-2962-1084

ร้านค้าและตัวแทนจ�ำหน่าย
โทรศัพท์	 0-2962-1081-3 ต่อ 112-114

โทรสาร	 0-2962-1084

PUBLISHED AND DISTRIBUTED BY

Visual Studio Code เป็นเคร่ืองหมายการค้าของบริษัท 

Microsoft Corp., MongoDB เป็นเคร่ืองหมายการค้าของ

บริษัท MongoDB และเคร่ืองหมายการค้าอื่นๆ ที่อ้างถึงเป็น

ของบริษัทนั้นๆ

สงวนลิขสิทธิ์ตามพระราชบัญญัติลิขสิทธิ์ พ.ศ. 2537 โดย

บริษัท ไอดีซี พรีเมียร์ จ�ำกัด ห้ามลอกเลียนไม่ว่าส่วนใด 

ส่วนหนึ่งของหนังสือเล่มนี้ ไม่ว่าในรูปแบบใดๆ นอกจากจะได้

รับอนุญาตเป็นลายลักษณ์อักษรจากผู้จัดพิมพ์เท่านั้น

บริษัท ไอดีซี พรีเมียร์ จ�ำกัด จัดตั้งขึ้นเพื่อเผยแพร่ความรู้ที่มี

คุณภาพสู่ผู้อ่านชาวไทย เรายินดีรับงานเขียนของนักวิชาการ

และนักเขียนทุกท่าน ท่านผู้สนใจกรุณาติดต่อผ่านทางอีเมลที่  

infopress@idcpremier.com หรือทางโทรศัพท์หมายเลข 

0-2962-1081 (อตัโนมัติ 10 คูส่าย) โทรสาร 0-2962-1084



ค�ำน�ำ

	 ในยุคปัจจบุนัการพัฒนาแอปแบบสร้างเพียง 1 โปรเจก็ต์แต่ได้แอปหลายประเภทก�ำลังได้รับความนิยม

เป็นอย่างสูง ในแพลตฟอร์มของ .NET มีโปรเจ็กต์ประเภทนี้เช่นกัน เรียกว่า .NET MAUI ผลผลิตของโปรเจ็กต์

ประเภท .NET MAUI คุณจะได้ทั้ง Desktop App, Web Apps และ Mobile Apps (iOS และ Android) ในเวลา

เดียวกัน โดยที่หนังสือเล่มนี้ยึดถือการพัฒนา .NET MAUI บน Windows เป็นหลัก แต่สามารถใช้ใน macOS 

ได้เช่นกัน อาจจะมีข้อแตกต่างในแง่ขั้นตอนใช้งานบ้าง แต่โค้ดยังคงใช้ได้เกือบทั้งหมด เพราะว่ามีโค้ดบางส่วน

ถูกสร้างขึ้นมาเฉพาะ Windows หรือเฉพาะ macOS ถือเป็นข้อจ�ำกัดทั่วไป

	 คุณผู้อ่านท่านใดที่ติดปัญหาหรือต้องการสอบถาม, ให้ข้อแนะน�ำ, ติติง รวมถึงข้อผิดพลาดต่างๆ ที่

อาจจะเกิดขึ้นได้ สามารถติดต่อกับผู้เขียนได้ 5 ช่องทาง คือ

	 1.	 แฟนเพจใน Facebook ชื่อว่า Thaivb.NET (https://www.facebook.com/thaivb.net)
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ศุภชัย สมพานิช

กันยายน 2023



.NET MAUI



Iสารบัญ

.NET M
AUIสารบัญ

บทที่ 1 	 การพัฒนาแอปด้วย .NET MAUI.........................................................................1

การดาวน์โหลดและติดตั้งโปรแกรม Visual Studio 2022.................................................... 2

สถานะของ .NET SDK..........................................................................................................6

การติดตั้งฟอนต์ Cascadia Code ส�ำหรับเขียนโค้ดโดยเฉพาะ.............................................7

การก�ำหนดให้แสดงหมายเลขบรรทัด...................................................................................9

การติดตั้ง .NET SDK เพิ่มเติม..............................................................................................9

การอัพเดตโปรแกรม Visual Studio...................................................................................11

วิธีการจัดเก็บโปรเจ็กต์ .NET..............................................................................................12

การดาวน์โหลด Android Emulator เพิ่มเติมเพื่อทดสอบโปรเจ็กต์แบบ Android Apps......15

ประเภทโปรเจ็กต์ .NET MAUI............................................................................................18

การยกเลิกฟีเจอร์ Nullable ของโปรเจ็กต์ ASP.NET Core Web API..................................19

บทที่ 2 	 พื้นฐานการพัฒนาแอปด้วย .NET MAUI.......................................................... 21

พื้นฐานการสร้างโปรเจ็กต์ .NET MAUI...............................................................................21

การสร้าง Android Emulator ของ Visual Studio ส�ำหรับทดสอบ Android Apps..............25

การปรับช่วงเวอร์ชันของ Android API...............................................................................28

การอัพเดต Android SDK ของ Visual Studio....................................................................30

การทดสอบโปรเจ็กต์ .NET MAUI แบบ Android Apps ด้วย Android Emulator...............30

การทดสอบโปรเจ็กต์ Android Apps บนเครื่องจริง (ใช้กับ Android 8.0 ขึ้นไปเท่านั้น)....32

การทดสอบโปรเจ็กต์ .NET MAUI แบบ Android Apps บนเครื่องจริง................................35

การรันโปรเจ็กต์ .NET MAUI ในรูปแบบ Windows Apps...................................................36

ท�ำความรู้จักกับโครงสร้างโปรเจ็กต์ .NET MAUI................................................................39

การสร้างเหตุการณ์ (Event) ด้วยวิธีการเขียนโค้ด.............................................................50

ท�ำความรู้จักกับฟีเจอร์แสดงผลทันที (Hot Reload)...........................................................54

วิธีการจัดเก็บโปรเจ็กต์ .NET MAUI....................................................................................55

การตรวจสอบแพลตฟอร์ม..................................................................................................57

การตกแต่งแถบข้อความด้วยอีลีเมนต์ <Border>…</Border>.............................................60

การลงแสงเงาให้กับรูปภาพ (Image Shadow)...................................................................62



II คู่มือพัฒนาแอปพลิเคชัน Multi-Platform ด้วย .NET MAUI

.N
ET

 M
AU

I

บทที่ 3 	 ต�ำแหน่งและ Layout ขั้นต้นของ .NET MAUI................................................... 64

การจัดเรียงแนวตั้งด้วย VerticalStackLayout....................................................................64

การจัดเรียงแนวนอนด้วย HorizontalStackLayout.............................................................66

การก�ำหนดระยะห่างด้วยคุณสมบัติ Margin.......................................................................67

การก�ำหนดระยะห่างภายในคอนโทรลด้วยคุณสมบัติ Padding..........................................69

การจัดต�ำแหน่งข้อความด้วยกลุ่มคุณสมบัติ TextAlignment..............................................72

พื้นฐานการสร้างช่องรับข้อมูลด้วยอีลีเมนต์ <Entry />.......................................................73

การแสดงเนื้อหาด้วย ContentView.....................................................................................79

พื้นฐานการใช้ Layout แบบตาราง Grid..............................................................................80

การรวมคอลัมน์ (Grid.ColumnSpan) หรือแถว (Grid.RowSpan) ใน Grid.......................83

ความหมายของการก�ำหนดขนาดแบบ Auto และ * ใน Grid..............................................85

การสร้าง Layout แบบเลื่อนดูเนื้อหาด้วย ScrollView.........................................................88

บทที่ 4 	 การใช้งานคอนโทรล (Controls) หรืออีลีเมนต์ (Element).............................. 90

พื้นฐานการตกแต่งคุณสมบัติ (Property) หรือแอ็ตทริบิวต์ (Attribute) ของคอนโทรล....90

การสร้างปุ่มกดด้วยคอนโทรล Button................................................................................91

การสร้างปุ่มกดแบบรูปภาพด้วยอีลีเมนต์ ImageButton....................................................93

การแสดงข้อความธรรมดาด้วย TextCell............................................................................96

การสร้างช่องรับข้อมูลแบบ EntryCell.................................................................................99

การสร้างตัวเปิด-ปิดสถานะด้วย SwitchCell................................................................... 101

การสร้างตัวเลือกวันที่ด้วย DatePicker............................................................................ 104

การสร้างตัวเลือกเวลาด้วย TimePicker........................................................................... 108

การสร้าง Resource ส่วนกลาง......................................................................................... 110

	 การสร้าง Static Resources แบบก�ำหนดค่าเดียว...................................................... 110

	 การสร้าง Static Resources แบบก�ำหนดหลายค่า (Style)........................................ 112

	 การสร้าง Dynamic Resources................................................................................... 115

การแจ้งเตือน (DisplayAlert).......................................................................................... 118

การตรวจสอบสถานะเชื่อมต่อ Internet ด้วยคลาส Connectivity.................................... 124

การสร้างตัวเลือกไฟล์ด้วยคอนโทรล FilePicker.............................................................. 127



IIIสารบัญ

.NET M
AUI

บทที่ 5 	 การผูกติดข้อมูล (Data Binding)................................................................... 132

พื้นฐานการเขียนโปรแกรมเชิงวัตถุ (Object Oriented Programming - OOP)............... 132

พื้นฐานการผูกติดข้อมูล................................................................................................... 133

การผูกติดระหว่างคอนโทรล (หรืออีลีเมนต์)................................................................... 143

โหมดการผูกติด (Data Binding Mode).......................................................................... 145

บทที่ 6 	 การสั่งให้เกิดการท�ำงานด้วยคลาส Command............................................... 149

การใช้งานคลาส Command............................................................................................. 149

การส่งพารามิเตอร์ให้กับ Command (Command Parameter)....................................... 157

การก�ำหนดค่าเริ่มต้นให้กับตัวเก็บสถานะ........................................................................ 163

บทที่  7 	 การพัฒนาแอปแบบหลายหน้าจอ................................................................... 166

พื้นฐานการเพิ่มหน้าจอใหม่เข้ามาในโปรเจ็กต.์................................................................ 166

การสร้าง Resource ใน App.xaml ส�ำหรับใช้ได้ทั้งโปรเจ็กต.์.......................................... 170

การรับ-ส่งข้อมูลระหว่างหน้า.......................................................................................... 173

การสร้างส่วนแสดงผลแบบแท็บ (Tab)........................................................................... 176

การสร้างเมนูส�ำหรับ Desktop Apps................................................................................ 180

บทที่ 8 	 การสร้างรายการด้วย ListView...................................................................... 185

พื้นฐานการสร้างรายการแบบ list ด้วย ListView............................................................ 185

การปรับแต่งรายการใน ListView..................................................................................... 189

การแบ่งการท�ำงานแบบ MVVM....................................................................................... 197

บทที่ 9 	 การท�ำงานกับฟังก์ชันพื้นฐานของอุปกรณ์ Mobile Devices 

	 (.NET MAUI Essentials)............................................................................... 209

ฟังก์ชันการโทรออก......................................................................................................... 209

การส่งข้อความ (SMS).................................................................................................... 214

การตรวจสอบ Hardware ด้วยคลาส DeviceInfo............................................................. 217

การตรวจสอบรายละเอียดแอปด้วย AppInfo................................................................... 220

การตรวจสอบสถานะ Battery.......................................................................................... 224

การตรวจสอบสถานะการเชื่อมต่ออินเทอร์เน็ต................................................................ 229

การเปิดเว็บเพจด้วย Browser.......................................................................................... 232

การ Copy & Paste ข้อความจากคลิปบอร์ด..................................................................... 234

การสร้างไฟล์เก็บข้อความส่วนกลาง (Shared Preferences).......................................... 237



IV คู่มือพัฒนาแอปพลิเคชัน Multi-Platform ด้วย .NET MAUI

.N
ET

 M
AU

I

บทที่ 10	 .NET MAUI Blazor......................................................................................... 241

พื้นฐานการสร้างโปรเจ็กต์ .NET MAUI Blazor App........................................................ 241

ท�ำความรู้จักกับโครงสร้างโปรเจ็กต์ .NET MAUI Blazor App.......................................... 245

	 Layout หลักของโปรเจ็กต์ .NET MAUI Blazor (MainLayout.razor)......................... 249

ระบบเมนู (NavMenu.razor)............................................................................................ 251

	 ส่วนแสดงผล Index.razor........................................................................................... 253

	 ส่วนแสดงผล Counter.razor....................................................................................... 256

	 ส่วนแสดงผล FetchData.razor................................................................................... 257

บทที่ 11	 พื้นฐานการสร้าง Web API ด้วย ASP.NET Core Web API............................ 265

ASP.NET Core Web API คืออะไร................................................................................... 265

การสร้างโปรเจ็กต์ ASP.NET Core Web AP.................................................................... 266

การทดสอบและหยุดรันโปรเจ็กต์ ASP.NET Core Web API............................................ 269

ท�ำความรู้จักกับโครงสร้างโปรเจ็กต์ ASP.NET Core Web API......................................... 274

การสร้าง Web API แรกด้วย ASP.NET Core Web API................................................... 279

บทที่ 12	 การสร้าง .NET MAUI Apps แบบ CRUD เชื่อมต่อกับ 

	 ASP.NET Core Web API (Front End)........................................................... 289

การสร้างโปรเจ็กต์ .NET MAUI แบบ CRUD.................................................................... 289

Repository Pattern ฝั่ง Front End.................................................................................. 297

การก�ำหนดให้ Android Emulator เชื่อมต่อกับ localhost............................................... 317

การสร้างหน้าจอแสดงรายการลูกค้า (MainPage.xaml).................................................. 320

บทที่ 13 	การสร้าง .NET MAUI Apps แบบ CRUD เชื่อมต่อกับ 

	 ASP.NET Core Web API (Back End)........................................................... 337

ท�ำความรู้จักกับโครงสร้างแบบหลายโปรเจ็กต.์............................................................... 337

	 Repository Pattern ฝั่ง Back End............................................................................. 342

วิธีการรันหลายโปรเจ็กต.์................................................................................................. 359



Vสารบัญ

.NET M
AUI

บทที่ 14	 พื้นฐานการพัฒนา Web Apps แบบคอนเทนเนอร์ด้วย Docker...................... 369

การดาวน์โหลดและติดตั้ง Windows Subsystem for Linux (WSL)................................ 370

การดาวน์โหลดและติดตั้ง Docker.................................................................................... 372

การท�ำงานกับ Docker Image/Container ในเบื้องต้น..................................................... 374

การลบอิมเมจ................................................................................................................... 381

บทที่ 15 	การสร้าง ASP.NET Core Web API ด้วย Docker........................................... 383

การสร้างโปรเจ็กต์ ASP.NET Core Web API ที่มีการใช้งาน Docker............................... 383

บทที่ 16	 การเผยแพร่อิมเมจแบบสาธารณะกับ Docker Registry................................. 392

การ push อิมเมจสู่ Docker Registry............................................................................... 392

บทที่ 17	 การสร้างไฟล์ Signed APK และ Signed AAB ด้วย .NET MAUI................... 399

การก�ำหนด Target Android Framework......................................................................... 399

วิธีการสร้างไฟล์ Key Store ให้กับ Android Apps........................................................... 400

การสร้างไฟล์ Signed APK และไฟล์ Signed AAB จากโปรเจ็กต์ .NET MAUI 

แบบ Android Apps......................................................................................................... 403

บทที่ 18 	การอัพโหลดแอปขึ้น Google Play Store........................................................ 406

การสมัครบัญชีนักพัฒนา Android Apps......................................................................... 406

ขั้นตอนการอัพโหลดไฟล์ Signed AAB ไปสู่ Google Play Store ................................... 409

บทที่ 19	 การสร้างไฟล์ติดตั้งของ .NET MAUI แบบ Windows Apps............................ 412

การสร้างไฟล์ .exe จากโปรเจ็กต์ .NET MAUI แบบ Windows Apps............................... 412

การสร้างไฟล์ Signed MSIX ส�ำหรับ Windows Apps...................................................... 416



.NET MAUI



1บทที่ 1 การพัฒนาแอปด้วย .NET MAUI

.NET M
AUI

บทที่

1
การพัฒนาแอปด้วย .NET MAUI

.NET MAUI เป็นความก้าวหน้าคร้ังส�ำคัญอีกก้าวหน่ึงของแพลตฟอร์ม .NET เป็นโปรเจ็กต์ 

ทีช่่วยให้นักพัฒนาสามารถสร้างแอปหลายแพลตฟอร์มในเวลาเดียวกันด้วยโครงสร้างโปรเจก็ต์เพียง

หนึ่งเดียว ช่วยให้ลดการดูแลรักษาโปรเจ็กต์ในระยะยาวได้อีกทางหนึ่งด้วย

	 ผลผลิตของโปรเจ็กต์ .NET MAUI สามารถสร้างแอปได้ 5 แบบ คือ

1.	 Windows Apps เป็นแอปประเภท Desktop บนเครื่อง PC

2.	 Android Apps เป็นแอปบนอุปกรณ์ของค่าย Google

3.	 iOS Apps เป็นแอปบนอุปกรณ์มือถือของค่าย Apple

4.	 Mac Catalyst Apps เป็นแอปประเภท Desktop บนเครื่อง MAC

5.	 Tizen เป็นแอปบนระบบปฏิบัติการของซัมซุง

เน้ือหาในหนังสือเล่มน้ีเป็นการใช้งานโปรแกรม Visual Studio บนเคร่ืองคอม PC ส่งผลให้ 

ผู้เขียนสามารถน�ำเสนอแอปได้ 2 ประเภท คือ Windows Apps และ Android Apps

เน้ือหาที่น�ำเสนอในหนังสือเล่มน้ีครอบคลุมการพัฒนาแอปในรูปแบบ Front End กับ Back 

End กล่าวคือ

1.	 งานฝั่งหน้าบ้าน (Front End) เป็นหน้าที่ของโปรเจ็กต์ .NET MAUI ท�ำหน้าที่สร้างส่วน

แสดงผลต่างๆ (User Interface - UI)

2.	 งานหลังบ้าน (Back End) เป็นหน้าที่ของโปรเจ็กต์ประเภท ASP.NET Core Web API 

ท�ำหน้าที่ติดต่อกับส่วนของข้อมูลเพ่ือให้บริการพ้ืนฐานในรูปแบบ Web API ได้แก่ งาน

ประเภทเพิ่ม, อ่าน, อัพเดต และลบข้อมูล (CRUD)
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การดาวน์โหลดและติดต้ังโปรแกรม Visual 
Studio 2022

การพัฒนาโปรแกรมในโลกของ .NET มีหลายวิธี หนังสือเล่มนี้อาศัยโปรแกรมที่ชื่อว่า Visual 

Studio 2022 มี 2 แบบ คือ

1.	 โปรแกรม Visual Studio เวอร์ชันปกติ เป็นเวอร์ชันที่เหมาะกับการน�ำไปใช้ในงาน  

Production จริง สามารถดาวน์โหลดมาใช้งานได้ฟรีที่ https://visualstudio.microsoft.

com/vs/

รูปที่ 1-1 แสดงเว็บส�ำหรับดาวน์โหลดโปรแกรม Visual Studio เวอร์ชันปกติ

2.	 โปรแกรม Visual Studio เวอร์ชัน Preview เป็นเวอร์ชันที่เหมาะสมกับกรณีที่ต้องการ

ทดสอบฟีเจอร์ใหม่ๆ ก่อนใคร มีความเสี่ยงกับบั๊กและ Error ต่างๆ มากกว่าเวอร์ชันปกติ 

ไม่แนะน�ำให้ใช้เวอร์ชันน้ีกบังาน Production จริง ใช้แค่ในระดับศกึษาเท่าน้ัน สามารถโหลด

มาใช้งานฟรีได้ที่ https://visualstudio.microsoft.com/vs/preview/

คลิก1
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รูปที่ 1-2 แสดงเว็บส�ำหรับดาวน์โหลดโปรแกรม Visual Studio 2022 เวอร์ชัน Preview

รูปที่ 1-3 แสดงการดาวน์โหลดตัวติดต้ังโปรแกรม Visual Studio 2022

ผู้อ่านสามารถติดต้ังโปรแกรม Visual Studio 2022 ทั้ง 2 เวอร์ชันได้ในเคร่ืองเดียวกัน  

ต่างคนต่างอยู่ มีวิธีการติดตั้งเหมือนกันดังนี้

1.	 ให้ผู้อ่านเลือกดาวน์โหลดตัวติดตั้งโปรแกรม Visual Studio 2022 Community Edition 

มาก่อน ดังรูปที่ 1-3

ฟีเจอร์ต่างๆ ที่ถูกน�ำมาทดสอบในเวอร์ชันน้ี เม่ือผ่านการทดสอบแล้วไมโครซอฟท์จะน�ำไป 

ใช้งานกับเวอร์ชันปกติในล�ำดับถัดไป ดังรูปที่ 1-2

คลิกเพื่อดาวน์โหลดตัวติดตั้ง VS 2022 เวอร์ชัน Preview2

คลิก1
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2.	 ให้ผู้อ่านดับเบิลคลิกไฟล์ที่ดาวน์โหลดมา เพ่ือเข้าสู่ข้ันตอนการติดต้ังโปรแกรม Visual 

Studio 2022 ผู้อ่านสามารถเลือกประเภทโปรเจ็กต์ที่สนใจได้อย่างอิสระ ขอบเขตการ 

น�ำเสนอเนื้อหาของหนังสือเล่มนี้ประกอบด้วย

	 	 •	 ASP.NET and web development ส�ำหรับพัฒนาโปรเจก็ต์ประเภท Web Apps ในกรณีน้ี 

สนใจเฉพาะโปรเจ็กต์ ASP.NET Core Web API

		  •	 .NET Multi-platform App UI development ส�ำหรับพัฒนาโปรเจ็กต์ประเภท .NET 

MAUI เป็นเนื้อหาหลักของหนังสือเล่มนี้

รูปที่ 1-4 แสดงหน้าจอเลือกติดต้ังประเภทโปรเจ็กต์

คลิก

คลิก

 คลิกเพื่อติดตั้ง

2.1

2.2

2.3
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3.	 ท้ายที่สุดให้ผู้อ่านรอการดาวน์โหลดและติดตั้งรายการต่างๆ ตามที่เลือกจนเสร็จสมบูรณ์ 

ถือว่าโปรแกรม Visual Studio 2022 พร้อมใช้งานแล้ว ดังรูปที่ 1-5

รูปที่ 1-5 แสดงการติดต้ังโปรแกรม Visual Studio เสร็จสมบูรณ์
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สถานะของ .NET SDK
หลังจากที่ไมโครซอฟท์รวม .NET Framework และ .NET Core เข้าด้วยกัน กลายเป็นยุค .NET 

ในปัจจุบัน มีนโยบายออก .NET SDK เวอร์ชันใหม่ปีละ 1 รุ่น ทุกๆ เดือนพฤศจิกายน มีสถานะ 

แตกต่างกัน กล่าวคือ

	 •	 .NET SDK เวอร์ชันเลขคี่ ได้แก่ เวอร์ชัน 5, 7 ... มีระยะเวลาสนับสนุนอัพเดตแพตช์แก้ไข 

18 เดือน เป็นเวอร์ชันที่เรียกว่า Standard-term support เรียกย่อๆ ว่า STS

	 •	 .NET SDK เวอร์ชันเลขคู่ ได้แก่ เวอร์ชัน 6, 8 ... มีระยะเวลาสนับสนุนอัพเดตแพตช์แก้ไข 

3 ปี เป็นเวอร์ชันที่เรียกว่า Long-term support เรียกย่อๆ ว่า LTS การพัฒนาโปรเจ็กต์

ในระดับ Production จริง ผู้เขียนแนะน�ำให้เลือกใช้เวอร์ชัน LTS เหมาะสมที่สุด

รูปที่ 1-6 แสดงรายละเอียดของ .NET SDK แต่ละรุ่น

.NET SDK เวอร์ชันใดก็ตามที่ใกล้หมดระยะเวลา Support เรียกว่า ระยะ Maintenance  

ถ้าโปรเจ็กต์ของเราใช้เวอร์ชันที่มีสถานะนี้ ควรที่จะอัพเดตไปใช้เวอร์ชันที่ใหม่กว่าให้เร็วที่สุด

ส่วน .NET SDK เวอร์ชันเก่า จะถูกจัดให้อยู่ในกลุ่ม Out of support versions เป็นเวอร์ชันที่

ไม่แนะน�ำให้ใช้งานในระดับ Production จริงแล้ว ผู้อ่านสามารถเลือกติดตั้ง .NET SDK ได้หลาย

เวอร์ชันในเวลาเดียวกัน
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รูปที่ 1-7 แสดงเว็บไซต์ที่ให้ดาวน์โหลดฟอนต์เขียนโค้ด

การติดตั้งฟอนต์ Cascadia Code ส�ำหรับ
เขียนโค้ดโดยเฉพาะ

ไมโครซอฟท์สร้างฟอนต์ส�ำหรับเขียนโค้ดโดยเฉพาะขึ้นมา ชื่อว่า Cascadia Code สามารถ

ดาวน์โหลดมาใช้งานได้ที่เว็บไซต์ https://github.com/microsoft/cascadia-code/releases  

ดังรูปที่ 1-7
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จากรูปที ่1-7 ให้แตกไฟล์ zip ทีไ่ด้มา เราสนใจฟอนต์ทีมี่นามสกุล .ttf เท่าน้ัน อยู่ในโฟลเดอร์

ทีช่ื่อว่า static ด้วย จากน้ันให้ผู้อ่าน Copy ฟอนต์ทีไ่ด้มาทัง้หมดไปวางไว้ในพาธ C:\Windows\Fonts 

รูปที่ 1-8 แสดงโฟลเดอร์ที่จัดเก็บรายการฟอนต์ในระบบ Windows 10/11

ให้ผู้อ่านเปิดโปรแกรม Visual Studio ข้ึนมา เลือกเมนู Tools > Options ทีหั่วข้อ Environment > 

Fonts and Colors เลือกใช้ฟอนต์ที่ชื่อว่า Cascadia Code Light

รูปที่ 1-9 แสดงการก�ำหนดให้โปรแกรม Visual Studio ใช้ฟอนต์ Cascadia Code Light

ข้อแตกต่างของฟอนต์ Cascadia Code กบัฟอนต์อืน่ๆ ทีน่่าสนใจ คอื สามารถแสดงสัญลักษณ์

พิเศษทางภาษาได้ เช่น เคร่ืองหมายหัวลูกศร เกิดมาจากการพิมพ์เคร่ืองหมาย = ติดกับเคร่ืองหมาย

มากกว่า > 

เลือก

เลือก

1

2
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การก�ำหนดให้แสดงหมายเลขบรรทัด
ส่วนการก�ำหนดให้ VS 2022 แสดงหมายเลขก�ำกับโค้ดในแต่ละบรรทัด โดยการเลือกเมนู 

Tools > Options… ให้ผู้อ่านไปที่หัวข้อ Text Editor > All Languages เลือกตัวเลือก Line numbers 

ดังรูปที่ 1-10

รูปที่ 1-10 แสดงการก�ำหนดให้แสดงหมายเลขก�ำกับโค้ดแต่ละบรรทัด

รูปที่ 1-11 แสดงการดาวน์โหลด .NET 7 SDK

การติดตั้ง .NET SDK เพิ่มเติม
เนื้อหาในหนังสือเล่มนี้ต้องการ .NET SDK เวอร์ชัน 7 ขึ้นไป ผู้อ่านสามารถติดตั้ง .NET SDK 

หลายเวอร์ชันในเวลาเดียวกัน ส่งผลให้โปรแกรม Visual Studio 2022 ของผู้อ่านสามารถสร้าง 

โปรเจ็กต์ได้ตามเวอร์ชัน .NET SDK ที่ถูกติดตั้ง มีขั้นตอนดังนี้

1.	 ให้ผู้อ่านไปที่เว็บไซต์ https://dotnet.microsoft.com/en-us/download/dotnet  

เพื่อดาวน์โหลด .NET 7 SDK เพิ่มเติม ดังรูปที่ 1-11 และรูปที่ 1-12

คลิกเลือก

คลิก1.1



10 คู่มือพัฒนาแอปพลิเคชัน Multi-Platform ด้วย .NET MAUI

.N
ET

 M
AU

I

รูปที่ 1-12 แสดงการดาวน์โหลด .NET 7 SDK (ต่อ)

จากรูปที่ 1-12 ผู้เขียนใช้งาน Windows 10/11 แบบ 64 บิต จึงเลือก .NET 7 SDK แบบ x64 

ผู้อ่านต้องตรวจสอบด้วยว่า .NET SDK ทีด่าวน์โหลดมาติดต้ังเพ่ิมเติมเอง  ต้องการโปรแกรม Visual 

Studio เวอร์ชันใด ในโปรแกรม Visual Studio ตรวจสอบได้ที่เมนู Help > About Visual Studio

NOTE
	 เม่ือมีการอัพเตด .NET SDK เวอร์ชันใหม่ ก็จะมีการอัพเดตโปรแกรม Visual Studio ควบคู่ 
มาด้วยเสมอ เพือ่ให้สามารถใช้งาน .NET SDK เวอร์ชันใหม่ได้นัน่เอง โดยปกติแล้วโปรแกรม Visual Studio 
เวอร์ชัน Preview มักจะได้สิทธิ์ทดสอบ .NET SDK เวอร์ชันใหม่ก่อนเวอร์ชันปกติ

2.	 ท้ายทีสุ่ดให้ผู้อ่านดับเบลิคลิกไฟล์ทีด่าวน์โหลดมา เพ่ือเข้าสู่ข้ันตอนการติดต้ัง .NET 7 SDK 

ใช้ค่าเร่ิมต้นที่มากับตัวติดต้ังทั้งหมด ส่งผลให้โปรแกรม Visual Studio 2022 สามารถ

พัฒนาโปรเจ็กต์บน .NET SDK ได้หลายเวอร์ชัน

คลิก1.2
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รูปที่ 1-13 แสดงการแจ้งเตือนอัพเดตของโปรแกรม Visual Studio

การอัพเดตโปรแกรม Visual Studio
ตัวโปรแกรม Visual Studio มีการอัพเดตอยู่เสมอ อาจจะเป็นการแก้ไขข้อผิดพลาดหรือ 

เพิ่มเติมฟีเจอร์ใหม่ๆ ก็ได้ แยกออกเป็น 2 กรณี

	 •	 Visual Studio เวอร์ชัน Preview เป็นเวอร์ชันที่ใช้ส�ำหรับทดสอบฟีเจอร์ใหม่ๆ ของ .NET 

SDK อยู่แล้ว ส่งผลให้มีการอัพเดตค่อนข้างบ่อย

	 •	 Visual Studio เวอร์ชัน Stable เป็นเวอร์ชันที่เราใช้งานจริงใน Production ของเรา  

หลังจากฟีเจอร์ต่างๆ ถูกทดสอบในเวอร์ชัน Preview จนกระทั่งสมบูรณ์แล้วก็จะน�ำมา

อัพเดตในเวอร์ชัน Stable มีระยะการอัพเดตห่างกว่าเวอร์ชัน Preview 

1.	 เมื่อตัวโปรแกรม Visual Studio มีอัพเดตใหม่ จะมีการแจ้งเตือน ดังรูปที่ 1-13



12 คู่มือพัฒนาแอปพลิเคชัน Multi-Platform ด้วย .NET MAUI

.N
ET

 M
AU

I

2.	 การดาวน์โหลดและติดตั้งอัพเดตต่างๆ ให้ปิดตัวโปรแกรม Visual Studio ก่อน ก็จะเข้าสู่

ขั้นตอนการอัพเดตโดยอัตโนมัติทั้งหมด ดังรูปที่ 1-14

รูปที่ 1-14 แสดงการอัพเดต Visual Studio เสร็จสมบูรณ์

วิธีการจัดเก็บโปรเจ็กต์ .NET
เป้าหมายของวิธีนี้คือ ต้องการลดขนาดไฟล์โปรเจ็กต์ให้มีขนาดเล็กลง โปรเจ็กต์ทุกประเภท

ของ .NET สามารถใช้วิธีการจัดเก็บโปรเจ็กต์แบบนี้ได้ มีขั้นตอนดังนี้
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1.	 ให้ผู้อ่านตรวจสอบขนาดโปรเจ็กต์ก่อนปรับปรุง โดยการคลิกขวาเลือกค�ำส่ัง Properties 

พบว่าขนาดโปรเจ็กต์ 883 KB แสดงดังรูปที่ 1-15

2.	 การปรับปรุงขนาดโปรเจ็กต์ .NET ท�ำได้โดยการเข้าไปในโฟลเดอร์ย่อยระดับแรกก่อน  

ผู้อ่านสามารถลบโฟลเดอร์ .vs ออกได้เลย ดังรูปที่ 1-16

รูปที่ 1-15 แสดงขนาดโปรเจ็กต์ก่อนปรับปรุง

รูปที่ 1-16 แสดงการลบโฟลเดอร์ .vs

ลบออก
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3.	 เข้าไปในโฟลเดอร์ย่อยอีก 1 ระดับ ให้ลบโฟลเดอร์ bin และ obj ออก ถือว่าเสร็จสิ้นแล้ว 

ดังรูปที่ 1-17

4.	 ให้ลองตรวจสอบขนาดโปรเจ็กต์อีกครั้ง พบว่าขนาดโปรเจ็กต์จะลดลงแล้ว ผู้อ่านสามารถ

น�ำโปรเจ็กต์ .NET ไปจัดเก็บได้แล้ว ดังรูปที่ 1-18

รูปที่ 1-17 แสดงการลบโฟลเดอร์ย่อย bin และ obj

รูปที่ 1-18 แสดงขนาดโปรเจ็กต์หลังปรับปรุงแล้ว

ลบออก
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รูปที่ 1-19 แสดงการเปิดโปรเจ็กต์ที่มีการปรับปรุงขนาด

รูปที่ 1-20 แสดงการเลือกค�ำสั่งเปิด/ปิดฟีเจอร์ของ Windows 10/11

5.	 การเปิดโปรเจ็กต์ที่มีการปรับปรุง

แบบน้ี ต้องรอให้เคร่ืองหมายตกใจ 

(!) ในหน้าต่าง Solution Explorer 

หายไปก่อน ก็จะใช้งานโปรเจ็กต์ได้

ตามปกติ

การดาวน์โหลด Android Emulator เพิม่เติม
เพื่อทดสอบโปรเจ็กต์แบบ Android Apps 

โปรเจก็ต์ประเภท .NET MAUI กบั .NET MAUI Blazor สามารถทดสอบแอปในรูปแบบ Android 

Apps ได้เช่นกัน โดยที่ผู้อ่านสามารถสร้าง Android Emulator ขึ้นมาเพื่อทดสอบโปรเจ็กต์ในขั้นต้น

ได้อีกด้วย มีขั้นตอนดังนี้

1.	 ใน Windows 10/11 ไปที่ Control Panel เลือกรายการ Uninstall a program > Turn 

Windows features on or off ดังรูปที่ 1-20

คลิก

คลิก

1.1

1.2
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2.	 ที่หน้าต่าง Windows Features ให้เปิดฟีเจอร์ Hyper-V แล้ว Restart เครื่อง 1 ครั้งก่อน  

ดังรูปที่ 1-21

3.	 ที่โปรแกรม Visual Studio ให้เปิด Android Device Manager ข้ึนมาก่อน จากน้ันคลิก 

ที่ปุ่ม  เพื่อเริ่มต้นดาวน์โหลดและติดตั้ง Android Emulator ดังรูปที่ 1-22

รูปที่ 1-21 แสดงการเปิดฟีเจอร์ Hyper-V ของ Windows 10/11

รูปที่ 1-22 หน้าต่างแสดงรายการ Android Emulator ในเคร่ืองของเรา

คลิก

คลิก

3.2

3.1

คลิก2
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4.	 ผู้อ่านสามารถก�ำหนดรายละเอียดให้กับ Android Emulator ที่จะสร้างขึ้นมาได้อย่างอิสระ 

แต่ผู้เขียนมีข้อแนะน�ำว่า ใช้ค่า default ก็ได้เช่นกัน ดังรูปที่ 1-23

รูปที่ 1-23 แสดงการดาวน์โหลด Android Emulator รายการแรกของเคร่ืองนี้

รูปที่ 1-24 แสดง Android Emulator ที่ได้มา

จากรูปที ่1-23 การดาวน์โหลดและติดต้ัง Android Emulator เป็นแบบอตัโนมัติทัง้หมด ผู้อ่าน

สามารถสร้าง Android Emulator ได้หลายรายการ เพือ่ทดสอบส่วนแสดงผลหลายขนาดได้อีกด้วย

คลิกเพื่อสร้าง Andriod Emulator

รอดาวน์โหลดจนเสร็จสมบูรณ์

คลิกเพื่อทดสอบเปิด Andriod Emulator

4.1

4.2

4.3
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5.	 ให้ทดสอบเปิด Android Emulator ข้ึนมา การ

ท�ำงานคร้ังแรกจะใช้เวลานานมากกว่าปกติ  

ดังรูปที่ 1-25

รูปที่ 1-25 แสดงการเปิด 

Android Emulator

การติดต้ัง Android Emulator มากกว่า 1 เวอร์ชันใน

เวลาเดียวกนัถอืเป็นเร่ืองปกติ ใช้ส�ำหรับทดสอบโปรเจก็ต์

ในขั้นต้น และต้องการตรวจสอบว่าส่วนแสดงผล (UI) ใน

หน้าจอที่มีความละเอียดแตกต่างกันให้ผลเป็นอย่างไร

ประเภทโปรเจ็กต์ .NET MAUI
การพัฒนาแอปแบบ .NET MAUI สามารถแบ่งออกได้เป็น 2 ประเภทหลัก คือ

1.	 .NET MAUI App ประกอบด้วย

		  •	 สร้างส่วนแสดงผล (User Interface – UI) ด้วยสคริปต์ภาษา XAML มีไฟล์นามสกุล 

.xaml

		  •	 โค้ดการท�ำงาน อาศัยภาษา C# มีไฟล์นามสกุล .cs

2.	 .NET MAUI Blazor App เป็นโปรเจ็กต์ที่อาศัยเทคโนโลยีฝั่งเว็บเป็นแกนหลัก ใน .NET 

เรียกว่า โปรเจ็กต์ Blazor ประกอบด้วย

		  •	 สร้างส่วนแสดงผล ด้วยสคริปต์ภาษา HTML + ส่วนขยายเพ่ิมเติม มีไฟล์นามสกลุ .razor

		  •	 โค้ดการท�ำงาน อาศัยภาษา C# มีไฟล์นามสกุล .cs
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รูปที่ 1-26 แสดงหน้าจอสร้างโปรเจ็กต์ .NET MAUI ทั้ง 2 ประเภท

เนื้อหาของหนังสือเล่มนี้น�ำเสนอเฉพาะโปรเจ็กต์ประเภท .NET MAUI เท่านั้น

การยกเลิกฟีเจอร์ Nullable ของโปรเจ็กต์ 
ASP.NET Core Web API

ส�ำหรับโปรเจ็กต์ประเภท ASP.NET Core Web API ที่เราจะใช้ในงานฝั่งหลังบ้าน (Back End) 

ผู้เขียนแนะน�ำให้ผู้อ่านยกเลิกฟีเจอร์ Nullable เป็นล�ำดับแรกก่อนเสมอ เพราะว่ายังไม่ได้ใช้ประโยชน์

อะไรกับฟีเจอร์นี้ โดยการดับเบิลคลิกที่ชื่อโปรเจ็กต์ก่อน จากนั้นแก้ไขค่าคุณสมบัติ Nullable ให้มี

ค่าเป็น disable ดังรูปที่ 1-27
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จากรูปที ่1-27 ให้เล่ือนมาด้านล่างจนถงึหัวข้อ Nullable ให้เลือกรายการ Disable เพ่ือยกเลิก

ใช้งานฟีเจอร์นี้

สรุปท้ายบท

เน้ือหาในบทน้ีเป็นเพียงการเตรียมสภาพแวดล้อมให้พร้อมกับการพัฒนาแอปด้วยโปรเจ็กต์

ประเภท .NET MAUI น�ำเสนอเป็นเนื้อหาตั้งแต่บทที่ 2 เป็นต้นไป

รูปที่ 1-27 แสดงการยกเลิกฟีเจอร์ Nullable

ดับเบิลคลิก
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บทที่

2
พื้นฐานการพัฒนาแอปด้วย .NET MAUI

เน้ือหาล�ำดับแรกของการพัฒนาแอปแบบ .NET MAUI กค็อื เราจะมาท�ำความรู้จกักบัโครงสร้าง

โปรเจ็กต์ .NET MAUI ในขั้นต้นก่อนว่ามีโครงสร้างและมีหลักการท�ำงานอย่างไร

พื้นฐานการสร้างโปรเจ็กต์ .NET MAUI 
มีขั้นตอนดังนี้

1.	 ที่หน้าจอเริ่มต้นของโปรแกรม Visual Studio ให้ผู้อ่านเลือก Create a new project เพื่อ

เร่ิมต้นสร้างโปรเจ็กต์ใหม่ ในกรณีน้ีผู้เขียนต้องการสร้างโปรเจ็กต์ประเภท .NET MAUI 

ท�ำได้โดยการเลือกที่ช่อง All project types ก�ำหนดให้แสดงรายการโปรเจ็กต์เฉพาะ .NET 

MAUI เท่านั้น ดังรูปที่ 2-1

คลิก1.1
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2.	 ในกรณีน้ีโปรเจ็กต์ .NET MAUI App แรกต้ังช่ือว่า BasicMAUI เก็บไว้ที่พาธ D:\MAUI  

(หรือพาธอื่นตามที่ผู้อ่านต้องการ) ดังรูปที่ 2-2

รูปที่ 2-1 แสดงการสร้างโปรเจ็กต์แบบ .NET MAUI App

คลิก1.2

ต้ังชื่อโปรเจ็กต์2

รูปที่ 2-2 แสดงการต้ังช่ือโปรเจ็กต์และพาธที่จัดเก็บ
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จากรูปที่ 2-2 ให้รอจนกระทั่งโปรแกรม Visual Studio สร้างโปรเจ็กต์แบบ .NET MAUI  

จนเสร็จสมบรูณ์ ถอืเป็นโครงสร้างโปรเจก็ต์เร่ิมต้นของเรา อาจจะมีโครงสร้างโปรเจก็ต์เร่ิมต้นเหมือน

หรือไม่เหมือนของผู้เขียนก็ได้ ไม่ถือเป็นเร่ืองส�ำคัญ เพราะว่าเม่ือผู้อ่านเข้าใจหลักการท�ำงานแล้ว 

โครงสร้างเริ่มต้นโปรเจ็กต์จะมีรูปแบบใดก็ได้

รูปที่ 2-3 แสดงโครงสร้างโปรเจ็กต์เร่ิมต้นแบบ .NET MAUI
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รูปที่ 2-4 แสดงการปรับแต่งโปรเจ็กต์ .NET MAUI เบื้องต้น

จากรูปที่ 2-4 ที่รายการ Build > General เลื่อนมาที่รายการ Nullable ให้ผู้อ่านยกเลิกใช้งาน

ฟีเจอร์ Nullable โดยการก�ำหนดค่า Disable ก่อน ถือว่าโปรเจ็กต์ .NET MAUI ของเราพร้อมใช้งาน

แล้ว (ใน .NET เวอร์ชันใหม่ ไม่ต้องก�ำหนดแล้ว)

คลิก3.2

คลิก3.3

3.	 หลังจากที่ผู้อ่านได้โปรเจ็กต์ .NET MAUI เร่ิมต้นมาแล้ว ขอให้ปรับแต่งการท�ำงานใน

ขั้นต้นก่อนทุกครั้ง โดยการเลือกเมนู Project > Properties ดังรูปที่ 2-4

คลิก3.1
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การสร้าง Android Emulator ของ Visual 
Studio ส�ำหรับทดสอบ Android Apps

ในข้ันต้นน้ีเราจะสนใจโปรเจ็กต์ .NET MAUI เฉพาะ Android Apps เป็นล�ำดับแรกก่อน  

โดยที่เรายังไม่ต้องแก้ไขหรือเขียนโค้ดใดๆ เพิ่มเติม เราต้องการทดสอบว่า Android Apps ที่ได้มา

มีหน้าตาเป็นอย่างไร

การทดสอบการท�ำงานของโปรเจ็กต์ Android Apps ในขั้นต้นคือ อาศัย Android Emulator 

ที่มากับโปรแกรม Visual Studio มีขั้นตอนดังนี้

1.	 ในโปรแกรม Visual Studio ยังไม่มี Android Emulator ใดๆ ทัง้ส้ิน ให้ผู้อ่านคลิกทีปุ่ม่    

จากน้ันคลิกทีปุ่ม่  เร่ิมต้นสร้าง Android Emulator เพ่ือทดสอบโปรเจก็ต์ .NET 

MAUI ประเภท Android Apps ดังรูปที่ 2-5

รูปที่ 2-5 แสดงการเร่ิมต้นสร้าง Android Emulator

2.	 เป็นขั้นตอนการก�ำหนดรายละเอียดให้กับ Android Emulator เพื่อจ�ำลองให้มีการท�ำงาน

เหมือนกับมือถือเครื่องจริง ที่ต้องก�ำหนด ได้แก่

	 •	 Name: ชื่อ Android Emulator

	 •	 Base Device: ให้ผู้อ่านเลือกรุ่นมือถือที่ต้องการจ�ำลองการท�ำงาน

	 •	 Processor: ให้ผู้อ่านเลือก CPU แบบ x86_x64 ตรงกับ CPU ที่ใช้งานในเคร่ือง PC  

ของเรา

คลิก2

คลิก1
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	 •	 OS: เลือกเวอร์ชันของระบบปฏิบัติการ Android ตามที่ผู้อ่านต้องการ

	 •	 ตัวเลือก Google APIs และ Google Play Store เป็นฟีเจอร์หลักของมือถอืตระกูล Android 

รูปที่ 2-6 แสดงการก�ำหนดรายละเอียดให้กับ Android Emulator

3.	 เข้าสู่ข้ันตอนการดาวน์โหลดรายการต่างๆ เพ่ือสร้าง Android Emulator ข้ึนมาตามที ่

ผู้อ่านก�ำหนดไว้ เป็นข้ันตอนอตัโนมัติทัง้หมด ให้ผู้อ่านรอจนเสร็จสมบรูณ์ก็จะได้ Android 

Emulator ส�ำหรับทดสอบโปรเจ็กต์ .NET MAUI แบบ Android ในขั้นต้น ดังรูปที่ 2-7

รูปที่ 2-7 แสดง Android Emulator ที่ได้มา

คลิก2

คลิกเพื่อรัน Android Emulator ขึ้นมา 3
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4.	 ในโปรแกรม Visual Studio ให้ผู้อ่านคลิกปุ่ม  ที่แท็บ Tools เลือกรายการติดต้ัง

เพิ่มเติมส�ำหรับโปรเจ็กต์ Android Apps ดังรูปที่ 2-8 

รูปที่ 2-8 แสดงรายการติดต้ังเพิ่มเติมส�ำหรับโปรเจ็กต์ Android Apps

จากรูปที่ 2-8 รายการที่ต้องติดตั้ง ประกอบด้วย

	 •	 Google Play services

	 •	 Google USB Driver

	 •	 Intel x86 Emulator Accelerator (HAXM installer) ส�ำหรับ CPU ของ Intel หรือรายการ 

Android Emulator Hypervisor Driver for AMD Processors (installer) ส�ำหรับ CPU ของ 

AMD ให้เลือกติดตั้งตาม CPU ที่ผู้อ่านใช้งานเพียงรายการเดียว

   คลิก4.1

คลิก4.2
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รูปที่ 2-9 แสดงรายการไฟล์ติดต้ังเพิ่มเติมส�ำหรับโปรเจ็กต์ Android Apps

จากรูปที่ 2-9 ให้ผู้อ่านรอขั้นตอนการดาวน์โหลดและติดตั้งจนเสร็จสมบูรณ์

การปรับช่วงเวอร์ชันของ Android API 
ในกรณีที่มีการอัพเดต Android SDK เวอร์ชันใหม่เข้ามา ผู้อ่านสามารถปรับแต่งช่วงเวอร์ชัน

โปรเจ็กต์ Android ของผู้อ่านให้รองรับเวอร์ชันใหม่ๆ ได้เช่นกัน แต่การปรับปรุงโปรเจ็กต์ให้เป็น

เวอร์ชันใหม่ดังกล่าว ไม่ได้หมายความว่าผู้อ่านสามารถใช้ฟีเจอร์ใหม่ๆ เหล่านี้ได้ทันที อาจจะต้อง

รออัพเดต .NET MAUI ให้เป็นเวอร์ชันใหม่ควบคู่กันไปด้วย (ผู้อ่านต้องรออัพเดตผ่านทาง Visual 

Studio) จึงจะสามารถใช้งานฟีเจอร์ใหม่ๆ ได้นั่นเอง 

การปรับช่วงเวอร์ชันของ Android API ให้ผู้อ่านเลือกเมนู Project > Properties ที่แท็บ  

Android Targets โดยที่

	 •	 ช่อง Minimum Target Android Framework หมายถึง Android เวอร์ชันต�ำ่สุดที่สามารถ

ติดตั้งแอปของเราได้

	 •	 ช่อง Target Android Framework หมายถึง ก�ำหนดเวอร์ชันหลักส�ำหรับ compile  

โปรเจ็กต์ เป็นไปตามเวอร์ชันที่ผู้อ่านดาวน์โหลดมา
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รูปที่ 2-10 แสดงการปรับแต่งช่วงเวอร์ชันของโปรเจ็กต์ Android Apps

คลิก1

คลิก2

เลือกเวอร์ชันของ Android API 3
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NOTE
	 การก�ำหนดเวอร์ชันต�่ำสุดของ Android API ผู้เขียนมีข้อแนะน�ำเพิ่มเติมว่า ขอให้ผู้อ่านติดตามการ
ประกาศจากฝั่ง Google เสมอว่า Play Store มีเงื่อนไขใดๆ เพิ่มเติมหรือไม่ ขอให้ผู้อ่านท�ำตามประกาศ
ดังกล่าวอย่างเคร่งครัด ในช่วงเวลาที่ผู้เขียนแต่งต้นฉบับหนังสือเล่มนี้อยู่มีข้อแนะน�ำว่า ควรจะปรับเวอร์ชัน
ต�ำ่สุดคือ Android 8.0 (API Level - 26) ขึ้นไป
	 ผลของการปรับเวอร์ชันต�ำ่สุดเป็น Android 8.0 หมายความว่า Android Apps ที่ผู้อ่านสร้าง 
ขึ้นมาสามารถติดตั้งบนระบบปฏิบัติการ Android 8.0 ขึ้นไปเท่านั้น

การอัพเดต Android SDK ของ 
Visual Studio

ส�ำหรับโปรเจก็ต์ Android ของ Visual Studio ผู้อ่านสามารถอพัเดต Android SDK เป็นเวอร์ชัน

ใหม่ล่าสุด เพื่อให้ Android Apps ของผู้อ่านรองรับฟีเจอร์ใหม่ๆ ได้นั่นเอง 

Warning
การอัพเดต Android SDK “ต้องท�ำในขณะที่โปรแกรม Visual Studio และ .NET MAUI มีการ

อพัเดตให้รองรบั Android SDK เวอร์ชนัใหม่แล้วเท่านัน้” โดยการตดิตามข่าวสารจากไมโครซอฟท์อยูเ่สมอ  
ยึดตามช่วงเวลาของผู้อ่านเป็นหลักว่าในช่วงเวลาของผู้อ่านมีการอัพเดตโปรแกรม Visual Studio และ 
.NET MAUI รองรับ Android SDK ถึงเวอร์ชันใดแล้ว

หมายความว่าถ้าผู้อ่านอัพเดต Android SDK เวอร์ชันใหม่ แต่โปรแกรม Visual Studio และ .NET 
MAUI ไม่รองรบั การอพัเดตดังกล่าวไม่มปีระโยชน์แต่อย่างใด อาจจะก่อให้เกดิข้อผดิพลาดระหว่างเวอร์ชนั
ได้อีกด้วย

การทดสอบโปรเจ็กต์ .NET MAUI แบบ  
Android Apps ด้วย Android Emulator

เนื้อหาที่น�ำเสนอในหนังสือเล่มนี้เป็นการใช้งาน .NET MAUI บนเครื่อง PC เป็นหลัก ส่งผล

ให้การทดสอบโปรเจ็กต์ทั้งหมดรันแบบ Android Apps มีความเหมาะสมที่สุด

การทดสอบโปรเจ็กต์ .NET MAUI แบบ Android Apps มี 2 วิธี คือ

1.	ทดสอบด้วย Android Emulator เป็นการทดสอบการท�ำงานโปรเจก็ต์ในข้ันต้น มีข้อดีกค็อื 

เราสามารถเห็นผลการท�ำงานใน PC ของเราได้เลย แต่มีข้อเสียก็คือ ความเร็วการทดสอบ

เป็นไปตามสเปคเคร่ืองของเรา และมีข้อจ�ำกัดของฟีเจอร์ต่างๆ ในระดับหน่ึง ในยุคปัจจบุนั

ผู้เขียนไม่แนะน�ำให้ทดสอบโปรเจ็กต์ด้วย Android Emulator แล้ว ใช้เท่าที่จ�ำเป็น
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2.	ทดสอบด้วยมือถือ Android จริง เป็นวิธีที่ผู้เขียนแนะน�ำให้ใช้เป็นหลัก เพราะว่าเราได้

ทดสอบและเห็นผลการท�ำงานบนมือถือจริง และยังช่วยลดระยะเวลาทดสอบโปรเจ็กต์ใน

แต่ละคร้ังอกีด้วย เกดิมาจากการทีเ่ราไม่ต้องสร้าง Android Emulator ใน PC ของเราน่ันเอง

ล�ำดับแรกเราจะมาทดสอบโปรเจก็ต์ BasicMAUI ด้วย Android Emulator ก่อน โดยการคลิกที่

หัวลูกศรในปุม่  จากน้ันเลือกโฟกสัโปรเจก็ต์ .NET MAUI 

เป็นแบบ Android Emulators ดังรูปที่ 2-11

รูปที่ 2-11 แสดงการทดสอบโปรเจ็กต์ .NET MAUI แบบ Android Apps

3.	 ให้คลิกทีปุ่ม่  เพ่ือรันโปรเจก็ต์ .NET MAUI แบบ 

Android Apps ดังรูปที่ 2-12 

รูปที่ 2-12 ผลการรันโปรเจ็กต์ BasicMAUI ใน Android Emulator

จากรูปที่ 2-12 ถือว่าโปรเจ็กต์ .NET MAUI ของเรารันในรูปแบบ Android Apps ได้แล้ว

เลือก2

คลิก3
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การทดสอบโปรเจ็กต์ Android Apps  
บนเครื่องจริง (ใช้กับ Android 8.0 ขึ้นไป
เท่านั้น)

เพ่ือให้การทดสอบผลการท�ำงานของ Android Apps สมบูรณ์ย่ิงข้ึน การทดสอบโปรเจ็กต์  

Android Apps บนเคร่ืองจริงถือเป็นช่องทางที่ดีที่สุดที่จะทดสอบการท�ำงานและฟีเจอร์ต่างๆ 

ในแอปของผู้อ่าน โดยเฉพาะอย่างยิ่งการใช้งานกล้อง, แผนที่ เป็นต้น

มือถือหรือแท็บเล็ต Android ที่จะน�ำมาใช้ทดสอบต้องมีการเปิดโหมดนักพัฒนา (Developer 

options) ก่อน ถ้ามือถือหรือแท็บเล็ตของผู้อ่านเคยท�ำมาก่อนแล้ว ไม่จ�ำเป็นต้องท�ำซ�้ำ สามารถใช้

ทดสอบโปรเจ็กต์ได้เลย 

ข้ันตอนการก�ำหนดในเคร่ืองจริงของแต่ละย่ีห้อ แต่ละรุ่น อาจจะมีรายละเอียดปลีกย่อย

แตกต่างกันไปบ้าง อาจจะใช้ค�ำที่ไม่เหมือนกัน แต่โดยรวมแล้วใช้หลักการเดียวกันหมด น่ันคือ 

เปิดโหมด Debug ขึ้นมาในเครื่อง มีขั้นตอนดังนี้

1.	 ให้ผู้อ่านเลือก Settings (ตั้งค่า) > ระบบ (System) > About (เกี่ยวกับ) ดังรูปที่ 2-13

รูปที่ 2-13 แสดงการดูข้อมูลเคร่ืองที่จะน�ำมาทดสอบ

เลือก1.1

เลือก1.2
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2.	 ให้ผู้อ่านเลือกข้อมลูซอฟต์แวร์ (Software Infomation) > หมายเลขบิลด์ (Build number) 

ดังรูปที่ 2-14

     

รูปที่ 2-14 แสดงหมายเลข Build number

3.	 ให้ผู้อ่านสัมผัสรายการ Build number (หมายเลขบิลด์) 7 คร้ัง ก็จะมีข้อความแจ้งว่า 

เปิดโหมดนักพัฒนาขึน้มาให้ผู้อ่านทราบ ถอืว่าเสร็จสมบรูณ์แล้ว หมายความว่าเคร่ืองของ 

ผู้อ่านเปิดโหมดนักพฒันา ส่งผลให้สามารถทดสอบโปรเจ็กต์ Android Apps จากภายนอก

ได้แล้ว ดังรูปที่ 2-15

รูปที่ 2-15 แสดงการเปิดโหมดนักพัฒนาในเคร่ืองจริง

เลือก2.1

เลือก2.2

คลิก3.1

คลิกจนข้อความขึ้น3.2
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4.	 ให้ผู้อ่านกดปุม่ Back กลับมา จะพบว่ามีรายการส�ำหรับนักพัฒนาซอฟต์แวร์เพ่ิมข้ึนมาใหม่ 

ให้เข้าไปเปิดโหมดส�ำหรับนักพัฒนา ดังรูปที่ 2-16

รูปที่ 2-16 แสดงการเปิดโหมดส�ำหรับนักพัฒนา

5.	 ให้ผู้อ่านเปิดโหมด Debug ขึ้นมา ถือว่าเครื่องของผู้อ่านพร้อมทดสอบโปรเจ็กต์ Android 

Apps แล้ว ดังรูปที่ 2-17

รูปที่ 2-17 แสดงการเปิดโหมด Debug ขึ้นมา

คลิก4.1

คลิก4.2

คลิก5.2

เล่ือนเปิดโหมด Debug USB 5.1


